The following declaration is applicable to equipment bearing the CE mark, manufactured for use in European Union and affiliated countries. It does not necessarily apply to non-CE marked equipment (although in many cases this will be manufactured to identical specifications).

**DECLARATION OF CONFORMITY**

The following declaration is made in application of Council directives:

73/23/EEC (Low Voltage Directive)
89/336/EEC (Electromagnetic Compatibility)

It is hereby warranted that the equipment described below complies with the requirements of the European standards:

EN 60065:1993 (Electrical Safety)
EN 55103-1:1996 (EMC - Emissions)
EN 55103-2:1996 (EMC - Immunity)

**Type of Equipment:** Conference Equipment

**Model Numbers:** DSC-50, DSC-100, CPM-401, CPM-402, SCP-300VT, SIOD-8

I, the undersigned, hereby declare that the equipment described herein conforms to the above Directives and Standards.

Signature: __________________________

Full Name: __________________________

Position: __________________________

Date: __________________________
## CONTENTS

<table>
<thead>
<tr>
<th>SECTION</th>
<th>TITLE</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>INTRODUCTION</td>
<td>1-1</td>
</tr>
<tr>
<td>1.1</td>
<td>Getting Started</td>
<td>1-3</td>
</tr>
<tr>
<td>1.2</td>
<td>ACCS-S Main Control Window</td>
<td>1-3</td>
</tr>
<tr>
<td>1.3</td>
<td>Shutting Down</td>
<td>1-3</td>
</tr>
<tr>
<td>2.0</td>
<td>MICROPHONE MANAGEMENT</td>
<td>2-1</td>
</tr>
<tr>
<td>2.1</td>
<td>Main Control Window</td>
<td>2-1</td>
</tr>
<tr>
<td>2.2</td>
<td>Microphone Control Panel</td>
<td>2-4</td>
</tr>
<tr>
<td>2.3</td>
<td>Speech Timing</td>
<td>2-6</td>
</tr>
<tr>
<td>2.4</td>
<td>On-Screen Mimic</td>
<td>2-7</td>
</tr>
<tr>
<td>2.5</td>
<td>Conference Journal</td>
<td>2-8</td>
</tr>
<tr>
<td>3.0</td>
<td>VOTING</td>
<td>3-1</td>
</tr>
<tr>
<td>3.1</td>
<td>Introduction</td>
<td>3-1</td>
</tr>
<tr>
<td>3.2</td>
<td>Vote Control Window</td>
<td>3-3</td>
</tr>
<tr>
<td>3.3</td>
<td>Voting Control Panel</td>
<td>3-2</td>
</tr>
<tr>
<td>3.4</td>
<td>Taking A Vote</td>
<td>3-3</td>
</tr>
<tr>
<td>3.5</td>
<td>Vote Result Files</td>
<td>3-4</td>
</tr>
<tr>
<td>4.0</td>
<td>OTHER FEATURES</td>
<td>4-1</td>
</tr>
<tr>
<td>4.1</td>
<td>Text Displays</td>
<td>4-1</td>
</tr>
<tr>
<td>4.2</td>
<td>Cameras</td>
<td>4-4</td>
</tr>
<tr>
<td>5.0</td>
<td>PREPARATION</td>
<td>5-1</td>
</tr>
<tr>
<td>5.1</td>
<td>Delegate Editor</td>
<td>5-1</td>
</tr>
<tr>
<td>5.2</td>
<td>Mimic Layout Editor</td>
<td>5-5</td>
</tr>
<tr>
<td>5.3</td>
<td>Microphone Test Utility</td>
<td>5-8</td>
</tr>
<tr>
<td>5.4</td>
<td>Vote Editor</td>
<td>5-9</td>
</tr>
<tr>
<td>6.0</td>
<td>INSTALLATION</td>
<td>6-1</td>
</tr>
<tr>
<td>6.1</td>
<td>General</td>
<td>6-1</td>
</tr>
<tr>
<td>6.2</td>
<td>Computer</td>
<td>6-2</td>
</tr>
<tr>
<td>6.3</td>
<td>Software Installation</td>
<td>6-2</td>
</tr>
<tr>
<td>6.4</td>
<td>Software Configuration</td>
<td>6-4</td>
</tr>
<tr>
<td>6.5</td>
<td>SIOD-8 Serial I/O Distribution Unit</td>
<td>6-15</td>
</tr>
<tr>
<td>6.6</td>
<td>System Control Panels</td>
<td>6-16</td>
</tr>
<tr>
<td>6.7</td>
<td>Video Distribution Amplifiers (VS-104/8)</td>
<td>6-18</td>
</tr>
<tr>
<td>6.8</td>
<td>Printers</td>
<td>6-18</td>
</tr>
<tr>
<td>6.9</td>
<td>Touchscreens</td>
<td>6-18</td>
</tr>
<tr>
<td>6.10</td>
<td>Wall Displays</td>
<td>6-19</td>
</tr>
<tr>
<td>6.12</td>
<td>Witness Camera System</td>
<td>6-20</td>
</tr>
<tr>
<td>6.13</td>
<td>Standard Serial Cables</td>
<td>6-20</td>
</tr>
</tbody>
</table>
A.1  VICON WITNESS CAMERA SYSTEM  A1-1
   A1.1  Installation  A1-1
   A1.2  Configuration  A1-1

A.2  JVC CAMERA SYSTEM  A2-1
   A2.1  Hardware Setup  A2-1
   A2.2  Software Configuration  A2-1
   A2.3  Operation  A2-3

A.3  AUDICAM CAMERA SYSTEM  A3-1
   A3.1  Hardware Setup  A3-1
   A3.2  Software Setup  A3-2
   A3.3  Operation  A3-4
ACKNOWLEDGEMENTS

IBM is a registered trademark of the International Business Machines Corporation.

Windows is a registered trademark of the Microsoft Corporation.

All other trademarks acknowledged.

LICENSE AGREEMENT AND LIMITED PRODUCT WARRANTY

DEFINITION OF TERMS:

“The Software’’ The ACCS-S control software or any of its components.

“The User’’ Any person(s) responsible for installing or using the ACCS-S software, including end users and agents.

“Authorised’’ Persons will only be deemed to be “authorised’’ to use The Software if they have purchased or otherwise obtained one or more copies by legal means, and with due authority from appointed agents.

GENERAL:

You must read the following terms and conditions and agree to abide by them before using The Software. Use or attempted use of The Software implies acceptance. If you do not agree to the terms and conditions, or have any queries regarding them, contact us immediately. Do not attempt to use The Software.

This agreement is to be governed by the laws of the United Kingdom.

COPYRIGHT:

The Software is protected by copyright and other laws. Ownership of the copyright is vested in Auditel and will remain so at all times. The copyright extends to the code itself and The Software’s appearance, structure and documentation.

LICENSE:

Auditel hereby grants The Authorised User a license to use The Software under the following conditions:

You are permitted to:

1. Install or use The Software on one “main” computer, which is linked to an conference system.
2. Install or use The Software on up to three other computers for preparation of data files for support purposes only.
3. Make no more than two copies of The Software on removable media for backup purposes only.
4. Freely distribute data files prepared using The Software, plus any voting results and journal files generated by The Software.

You must not:

1. Make unauthorised copies of The Software for use on other systems, or pass such copies to third parties.
2. Either knowingly, or by act of omission or neglect, permit unauthorised copies of The Software to be made. This means that you should take reasonable care to protect The Software from unauthorised copying.
3. Transfer The Software or the license to another owner without the knowledge and written authorisation of Auditel. Given such authorisation, The Software may only be transferred along with the associated conference system. All copies must be transferred – previous users must not retain any copies of The Software, or its documentation.
4. Decompile or reverse engineer any part of The Software, or attempt to do so.
5. Copy, publish, revise or otherwise alter the documentation, or transmit it by any method.

Failure to observe the above conditions will automatically terminate your license and may render you liable to criminal and/or civil action.

LIMITED WARRANTY:

1. Except as specifically stated in this agreement, The Software is provided and licensed “as is” without warranty of any kind, either express or implied, including, but not limited to the implied warranties of merchantability and fitness for a particular purpose.
2. Auditel warrants that The Software will substantially perform the functions or generally conform to the specifications published by Auditel, and included in this manual.
3. Auditel warrants that the disks on which The Software is provided will be free from defects in materials and workmanship and will remain so under normal use for a period of 12 months from the date of delivery.
4. Auditel does not warrant that the functions contained in The Software will meet your requirements. It is the responsibility of The User to ensure that The Software will meet the intended requirements prior to purchase.
5. Every care is taken to ensure that The Software is error free and that the documentation accurately describes its features and operation. However, no warranty is given that this will be so.
6. Other than required by law, Auditel will not be liable for any damages, including lost profits, lost savings, or other incidental or consequential damages, arising out of the use or inability to use The Software - even if Auditel, or one of its agents, has been advised of the possibility of such damages.
7. No warranty is given that The Software will function correctly on any computer system other than one supplied by us.
8. If any provision of this agreement is held to be unenforceable, this shall not affect the enforcement of the remaining provisions.
1.0 INTRODUCTION

This manual describes the features and functions of the Computer Control System (ACCS) and its Windows®-based software (ACCS-S) for use in conjunction with the Envoy Discussion System. The elements of information are presented in the order in which they will tend to be most often referred to – i.e. Operation, Configuration and Installation.

The ACCS is based around an industry standard IBM® compatible Personal Computer (PC). This communicates with the Discussion System Controller in the Envoy Microphone/ Voting System to facilitate display and control of the system status.

The ACCS-S software provides microphone management and (optionally) voting and speech timing facilities. These functions are accessed directly from the computer screen in a “point and click” fashion using the mouse.

A comprehensive set of microphone management controls and facilities are provided to enable rapid and smooth microphone selection during a conference. Prior to a meeting, delegate information (e.g. names, party or country represented) can be pre-entered and stored on disk. This information is displayed onscreen during the conference when the delegates request to speak and while their microphones are enabled.

For systems with voting, various voting modes can be preset to suit different applications. Again, control is easily performed via the mouse. Votes are stored on disk and can be archived, copied and printed out at any time.

Here, the DSC controller connects to the PC via the latter’s “native” serial port (or via a USB to Serial adaptor if one is not built in).

![Fig. 1.1 – Simple Envoy ACCS Example Schematic](image)

If more than one peripheral devices must be connected then computer is supplied with special quad RS-232 serial ports card with four ports or a special RS-232 distribution unit SIOD-8 with capacity for up to 8 serial ports which also can provide power to drive or activate certain peripherals.
Fig. 1.2 – Comprehensive Envoy ACCS Example Schematic

PC – This is the heart of the ACCS. Here it is shown as a desktop (as opposed to a “laptop” or “notebook”) style computer with expansion cards fitted – notably two Quad Serial Port cards, and a Dual Head graphics card.

VDA – Video Distribution Amplifier. Required if additional video feeds are to be provided to auxiliary monitors or projectors.

CD300C – Auxiliary display monitor. This can be a touchscreen type to make a secondary control point available.

SCP-300VT – System Control Panel that allows microphone, voting and speech timing control functions to be performed. Often used in conjunction with auxiliary monitors to provide secondary control positions. The “T” version has Speech Timing control facilities and will directly drive mains voltage signalling lamps.

CH300V – Small panel with a few key controls, intended for use by the meeting chairman.

Camera Controller – Via which ACCS-S can direct cameras to preset shots.

Printer – For printing voting results and journal.

DSC50/100 – Envoy Discussion System network controller.

This manual assumes that the reader is familiar with IBM® PC-compatible computers, and the Windows® operating system. Further information on these can be obtained from the manuals accompanying the computer, or from commercially available literature.

Installation and configuration of the hardware and software requires a good level of familiarity and competence. It is strongly recommended that the equipment is purchased pre-installed at the factory, or is installed on site by an engineer.

The comprehensive nature of the software and its continuing improvement means that this manual cannot fully describe all the features and options available. Users are encouraged to spend as much time as possible experimenting with the system in order to familiarise themselves with its operation before using it in a real conference situation.
1.1 GETTING STARTED

On applying power to the system, the computer will go through its initialisation sequence. This generally takes one or two minutes, after which the monitor will display the Windows® desktop.

ACCS-S can be started either via the Start menu, or by double-clicking on the icon on the desktop. As with most applications, the software can be configured to auto-start when the computer is powered up.

Important Note:

The ACCS is a real-time control system that happens to be based on a general purpose PC platform. If other applications are installed on the computer, it is essential that these are not active while ACCS-S is being used to control the conference system. Otherwise there may be resource conflicts that can prevent the proper operation of the system.

1.2 ACCS-S MAIN CONTROL WINDOW

Once the software has loaded, the Main Control Window will be displayed. This can be repositioned, but it is usually best to leave it at the left-hand side of the screen. It cannot be resized.

The Main Control Window contains the basic tools for microphone management and these will be covered in greater detail in the following sections.

In the right hand area, a “mimic” layout of the microphone positions is displayed. The various other windows associated with the Conference Control System are also displayed here. These windows are brought into view by means of buttons on the Toolbar above the workspace area. Passing the mouse cursor over a button will bring up hint text that explains its function.

1.3 SHUTTING DOWN

To exit ACCS-S, click on the button at the top right hand corner of the Main Control Window. A dialogue box appears giving the option of exiting with:

- The current operating mode unchanged.
- The system set to Delegate Mode. If already operating in this mode, ACCS-S will exit without changing anything.
- Microphones and Requests cancelled.

Confirm your requirement and click on Ok to exit, or Cancel to return to ACCS-S.

After exiting, the computer may be used to run other applications, or shut down via the Windows® Start menu as normal.

N.b. It will not be possible to exit ACCS-S while a vote is in progress – close the vote before attempting to exit the program.
2.0 MICROPHONE MANAGEMENT

The computer provides four means by which the microphones can be controlled:

1. Using the microphone control facilities in the Main Control Window.
2. Via an onscreen “mimic” representation of the seating layout.
3. By means of a Microphone Control Panel (MCP) in a SCP-300 console.
4. Via a “virtual” (onscreen) Microphone Control Panel (MCP).

The screen-based options - 1, 2 & 4 - utilise the Windows® pointing device, which may be a mouse and/or a touchscreen monitor.

2.1 MAIN CONTROL WINDOW

Figure 2.1 opposite shows the microphone control section of the ACCS-S Main Control Window.

At the top of the window is the title bar. Immediately below is the menu bar with File, Options, Help & View pull down menus. These are explained in further detail below.

In the main body of the window are several scrollable boxes, which display information as described below. These are dealt with from bottom to top, reflecting the “flow” of a delegate through a typical request/speak process. Note that the actions of controlling the microphones will only occur if the computer is connected to the microphone system, and the system is powered.

Note that the sizes of some of the boxes can be adjusted to preference (within limits) by clicking on the red lines at the bottom of the box and dragging it up or down.

2.1.1 DELEGATES

This is essentially a window on the delegate file. It is possible to browse through the file using the scroll bars and select delegates. Double clicking an entry with the left mouse button causes the delegate’s microphone to be switched on immediately.

By default the delegate list is sorted by microphone (seat) number. Different sort options are available via the View menu.

Fig. 2.1 – Main Control Window
2.1.2 REQUESTS

This is a list of microphone units currently requesting, in reverse chronological order (most recent request at the bottom). To activate a microphone in the list, move the cursor over the entry and double click the left mouse button. The first five (Q1-Q5) can also be turned on via the corresponding buttons on the MCP. There is no limit on the number of requests that can be stored.

2.1.3 WITHDRAWN REQUESTS

This is a list of units that have cancelled their request condition, in reverse chronological order (most recent at the top). This is useful when inexperienced users accidentally cancel their request condition; the operator can “recover” them quickly by locating them in this list box. Units that have had their requests cancelled via the computer also appear here.

2.1.4 LIVE MICROPHONES

This is a list of the currently live microphones, in chronological order (newest speaker at the bottom). To turn a microphone in the list off, move the cursor over the entry and double click the left mouse button. The first four (M1-M4) can also be turned off via the corresponding buttons on the MCP.

The maximum number of live delegate microphones permitted is 15.

2.1.5 CHAIRMAN

The chairman’s entry is displayed permanently. The unit can be enabled by double-clicking on the entry with the left mouse button. The line is highlighted in red when the chairman’s microphone is on. When the chairman’s unit is in priority mode, the entry is highlighted in yellow; any live microphones will be temporarily cut off. In either case, the microphone can be switched off by double-clicking with the left mouse button. Up to three chairman’s units are supported. The (first) chairman’s microphone can also be turned on and off via the CH ON/OFF buttons on the MCP.

2.1.6 PREVIOUS SPEAKERS

This contains a list of previous speakers. Any of these can be re-enabled by double clicking them with the left mouse button. The most recent can be also be re-enabled using the P1 key on the MCP.

2.1.7 RIGHT-CCLICK OPTIONS MENU

Right-clicking on a delegate entry in any of the list boxes will cause an options list menu to appear. This is context-sensitive – i.e. the options available depend upon the current status of the unit. The options include:

- **Request (insert)** – Puts the unit in request mode and inserts at the head of the request queue (Q1 position).
- **Request (append)** – Puts the unit in request mode and adds to the end of the request queue.
- **Clear Request** – Removes the unit from the request queue.
- **Enable Mic** – Switches on the corresponding microphone.
Message LED – This function is not applicable to the Envoy system.

Edit – This option brings up the Delegate Editor window, allowing the delegate name, or other details to be quickly changed “on the fly” (refer to the Preparation section for further details of the Delegate Editor). The delegate file is not updated with such changes, but a prompt will be issued to save any changes when ACCS-S is closed.

2.1.8 CONTROL BUTTONS

Below the list boxes are a number of control “buttons”:

Clear Reqs – Clears all current requests (note that this “global” command does not move the current requesting units to the Withdrawn Requests box).

Cancel Mics – Clears all currently live microphones (except chairman’s microphone).

Auto – Pressing this button advances the Live Microphone/Request lists by one. So, the current speaker (M1) will be switched off (→P1) and the unit at the head of the request queue (Q1) is made live. The total number of live microphones is preserved, so long as there are requesting delegates available to be “promoted” to live microphone status.

The above three buttons replicate the functions of those on the Microphone Control Panel.

In addition, there are also “radio” buttons for selecting the operating mode – Delegate or Central. In Central Mode, the microphones are controlled centrally by the operator - delegates can only request to speak. This is the usual operating mode for a computer-controlled system. In Delegate Mode, the microphones are turned on and off directly by the delegates themselves and operator intervention is unnecessary. Delegate Mode tends only to be appropriate for small, well-disciplined meetings, but it is also useful for test purposes.

2.1.9 MENU OPTIONS

The File, Options View and Help pull down menus are accessed via the Menu Bar near the top of the System Status Window.

File

The options within this menu and their functions are as follows:

• Load Delegates - Loads in a new delegate file. The default file loaded when the system is started is usually named DEFAULT.DEL. If the system is used mainly with one file, it is usually convenient to give it this name. Other files have to be loaded specifically using this method.

• Exit - Exits the Microphone Control program.

Options

Selects operating mode options as follows:

- Non Card Mode
- Card Mode
- Card Key Mode
- Mixed Card Mode

The card modes are not applicable to the Envoy system and Non-Card Mode should therefore always be selected.
**View** – Brings up a sub-menu via which it is possible to open various control and display windows. These are dealt with later in this and other sections.

**Help** This brings up any relevant help text available.

### 2.1.10 HINT TEXT
As the mouse pointer is moved over certain areas of the screen, a small box will appear containing “hint text”. This will either give information as to the function of a particular button, or perhaps the name of a delegate. The box disappears after a few seconds.

### 2.2 MICROPHONE CONTROL PANEL

The second option for controlling the microphones is via a SCP-300 series control console. This incorporates a Microphone Control Panel, the layout of which is shown in Fig. 2.2 below.

The controls are arranged in four groups according to their functions.

#### 2.2.1 NORMAL MODE

The usual procedure for a meeting is that delegates wishing to speak press their request buttons. These delegates are entered into the computer's memory in order, and are displayed on the screen in the Requests box. Any of the first five of these delegates (Q1-5) can be enabled by pressing the corresponding key in the Normal Mode group on the MCP.

When a delegate microphone is enabled, the entry is removed from the request queue and added to the end of the list in the Live Microphones box (M1 etc.).

Microphones can be turned off by means of the buttons M1-4 on the MCP. The last delegate to be turned off is moved up to the P1 position. There is a key corresponding to the P1 entry that allows the Previous Speaker to be quickly re-enabled if necessary.

Whenever a delegate is removed from the Request or Live Mics queues, the entries below all shuffle up a place, preserving their original order.

The PAGE button is not used in conjunction with the Windows® software.

The CANCEL MICS key can be used to switch off all currently live microphones. Similarly, the CLEAR REQUESTS function clears down all requests - e.g. when moving on to discuss the next item on the agenda.

Underneath the CLEAR REQUESTS key is an LED indicator. This is activated by a button on the Chairman Auxiliary Control Panel (CH-300V) to indicate to the operator that requests should be cleared. The LED will extinguish once CLEAR REQUESTS has been pressed.
The chairman unit can be turned on and off via the dedicated buttons. It is possible to turn off even when in Priority mode. The standard MCP only provides facilities for control of one chairman unit (CH0).

### 2.2.2 KEYPAD FUNCTIONS

The keypad and associated buttons facilitate three additional functions. These are the entering and deleting of delegates in the request queue, and the Message Waiting function.

The Enter function allows any delegate to be inserted at the head of the request queue (i.e. into the Q1 position). The delegate's microphone number is typed in at the keypad and appears in the display window above. If incorrectly entered, it can be cancelled at this stage with the C (Cancel) key without affecting the microphone status. When ready, pressing the ENTER key moves that delegate into the Q1 position, all other members of the queue moving down one position. The delegate can then be switched on when required using the Q1 button. Note that any delegate can be entered, regardless of whether or not they are already in the queue.

A similar procedure can be used to remove a delegate from the request queue. After entering the microphone number via the keypad, the delegate is removed by pressing the DELETE button.

The Message Waiting function is used to attract the attention of a particular delegate by illuminating an indicator on his delegate station (where fitted). This could act as an instruction for him to leave the meeting and take an urgent message or telephone call. To activate the indicator on a unit, enter the microphone number on the keypad as above then press the Message Waiting (envelope graphic) button above. The lamp on the unit will be automatically turned off after approximately 2 minutes.

### 2.2.3 AUTO MODE

Often in a meeting it is required to switch off the current speaker (M1) and then enable the next speaker (Q1). The Auto Mode key achieves this in a single action. If there is more than one live microphone, M1 will be the one that is switched off with Q1 moving to M2, M3, or M4 as appropriate. If there are no requests when the key is pressed, M1 will still be turned off. Conversely, if there are no live microphones, Q1 will still be made live.

### 2.2.4 DISCUSSION MODE

These keys are not used in conjunction with the Windows® software.

### 2.2.5 MESSAGE DISPLAY

These buttons are used to activate the message display function in systems incorporating display panels. Please refer to the Text Displays section in this manual for further details.

A window containing a “virtual” representation of the Microphone Control Panel can be displayed on the screen. All the functions of the physical panel are duplicated and can be activated via the mouse. See the Other Features section in this manual.
2.3 SPEECH TIMING

Automatic speech timing is a standard feature of the system. Control of the timing is performed either via a special panel (see fig. 2.3 below), normally incorporated in a SCP-300VT control console, or its “virtual” equivalent, which appears at the bottom of the Microphone Control window (see fig. 2.4 below).

The timer may be set to either count down from a preset time, or to measure elapsed time. The selected time is set up (in minutes) on the panel's digital indicator using the seven Minutes Set buttons as follows:

- ↑↓ These increment or decrement the allotted time by one or ten minutes each time they are pressed.

- T1 T2 The timer can be set to either of two preset values using these buttons. The actual times are determined in the software configuration and will typically be 5 and 10 minutes respectively.

- ZERO Sets the timer to zero. When set thus, the timer will count up to record elapsed time when triggered.

The timer can operate in either Manual or Automatic mode – as determined by the AUTO switch on the Speech Timer Control Panel. When the indicator above this switch is illuminated, the timer is in Auto mode. The default mode on power up is determined by the system configuration. In Auto Mode, the timer automatically times the current speaker. In Manual Mode, the timer is started manually by the operator using the START button on the panel.

Once triggered, the timer will start to count down from its initial setting (or up if initially set to zero). The green "Run" indicator flashes to indicate timing in progress, and the count is displayed at the bottom of the Microphone System Status window. Timing may be suspended if required by pressing the HOLD button, whereupon the indicator will cease to flash. Pressing HOLD a second time will allow the timing to continue. If the timer is in count-down mode, the "1 min" indicator will flash during the final minute instead of "Run", and the "End" indicator will illuminate at the end of the timing interval.

To abort a timing interval, regardless of mode, press RESET.

The SCP-300VT incorporates switched mains outlets to drive external indicator lamps. These will echo the Run, 1 min and End conditions (but do not flash). The external lamps extinguish while timing is suspended; they do not operate while in elapsed time mode.

Notes:

1. In Auto mode, the delegate timed is always M1, regardless of how many microphones are live at any time. Timing starts from the beginning when a speaker becomes M1, even though his microphone may already have been live for some time.
2. The Manual mode, the timer can be started manually, even if there is no current speaker.

3. Timing is automatically suspended if the Chairman's Priority is exercised.

4. Although the timer is set in minutes (0-99), it is displayed on screen in hours, minutes and seconds.

5. The time setting on the panel can be changed while the timer is running. The current timing interval is unaffected.

6. To inhibit the timer, select manual timing mode and reset. The external lamps (if fitted) will extinguish and the timer will not then run unless the operator starts it manually.

### 2.4 ON-SCREEN MIMIC

Figure 2.5 shows a view of a typical complete Microphone Control window.

This incorporates an on-screen “mimic” layout in the “workspace” area to the right of the microphone control window. The mimic screen is created by a separate application that is described in the Preparation section.

It is possible to “move” an icon by holding down the shift key on the keyboard and dragging with the mouse. The change is not saved and the icon will revert to its original position next time the program restarts. It can be useful for radio and stand mics.
Microphone status is displayed on the mimic layout by means of coloured icons. Normally the icons are grey, turning to green when a delegate requests, and red when their microphone is made live. The chairman's icon turns to yellow when the priority mode is invoked.

Microphones can be turned on and off by single-clicking on the icons with the mouse. The single-click facilitates the use of a touchscreen monitor for microphone switching.

Right-clicking on one of the icons will produce a context sensitive menu. If the mouse pointer is moved over an icon, a hint text box appears showing the name of the delegate corresponding to that seat position (if any).

## 2.5 CONFERENCE JOURNAL

Every time that ACCS-S is started, it creates a log file, or journal. This contains a complete list of all the transactions on the system, with each transaction time stamped. Thus, by examining the journal file it is possible to identify which microphone was live at any particular time. This can be useful when transcribing recorded proceedings.

Journal files are automatically named to reflect the time and date they were created. They are given a .LOG extension. The directory where the files are stored is normally:

```
c:\Program Files\Auditel\Log
```

The files can be opened using one of the standard Windows® text editors – e.g. Notepad or Wordpad.

In fact, two log files are created for each session. One is an “Audit” file, which is identified as such in the file name. This contains detailed system diagnostic information and is not to be used.
3.0 VOTING

3.1 INTRODUCTION

This section explains the process of taking a vote.

As standard, Envoy units are equipped with 3 voting buttons. The software caters for other systems which can have up to 5 voting buttons; clearly these options can be ignored.

The computer provides three means by which voting can be controlled:

1. Using the facilities in the Vote Control Window.
2. By means of a Voting Control Panel (VCP) in a SCP-300V console.
3. By means of the controls in a CH300V console.

3.2 VOTE CONTROL WINDOW

The Vote Control window can be called up onto the screen by clicking on the corresponding icon above the workspace area (Fig. 3.1). The Voting Control window appears as shown in figure 3.2. In fact, what is shown is the Expanded view of the VCW.

Considering the left hand side first, in the upper part of the window is a box containing a list of pre-prepared votes contained in a Vote Template File. The facility allows a number of vote templates to be created prior to a meeting with various parameters (e.g. type, title, proposer, seconder, duration) and stored on the hard disk. These can then be recalled in (or out of) sequence during the session. Any number of different template files can be created and recalled for particular meetings. The one that will be loaded in by default when ACCS-S is started is the DEFAULT.VTF file. Normally this file has just one vote template in it, which is adequate for most users – at least as a starting point.

During the session, as each new vote is started, the parameters will be taken from the next template in the list. It is possible to jump out of sequence by double-clicking on the required template with the mouse.

Fig. 3.2 – Vote Control Window
The Vote Countdown section at the bottom left of the window contains the controls for starting and stopping the vote, and for setting the voting period.

On the right hand side of the window is a list box. When a vote is started (as shown here), this box is filled with a list of the delegate names. As each person votes, their name becomes highlighted with a coloured background as appropriate.

Below the list box is a Division Bell control section, for those systems equipped with this facility.

A user prepared Vote Template File may be loaded by selecting the Open option from the File menu. If most votes are of a particular type, it makes sense to create a VTF file containing just this one type of vote, then rename the file to DEFAULT.VTF so that it is loaded in by default every time ACCS-S is started. If this is done, it is recommended that the original DEFAULT.VTF is renamed to say BACKUP.VTF.

The View menu gives the option of displaying the Vote Control window in either Expanded, Normal or Condensed forms. The Normal view is basically just the left-hand section of the Expanded view shown above. The Condensed view is made slightly smaller still by omitting the vote Number, Proposer and Seconder boxes.

The Output menu allows the presentation style of the selected vote to be modified. These changes only take effect while the vote is selected and are intended just to allow immediate one-off changes to the vote presentation.

To initiate a vote, select it with the mouse then double click it. The Motion, Options, Proposer, Seconder, Mode, Time and Print Inhibit attributes of the selected vote then appear in the entry boxes below the main list box. It is possible to modify them at this point if desired. Thus, if all votes tend to be similar, a user VTF may never need to be created - a default vote is called up and modified each time as required.

If there is a SCP300V and/or CH300V control console in the system, the parameters such as voting mode (Open, Secret etc.) and countdown time will appear on them also. Indeed, it is possible to modify the parameters from these consoles if desired.

## 3.3 VOTING CONTROL PANEL

The Voting Control Panel is fitted in SCP-300V control consoles. It may also be permanently installed in a desk or form part of a custom control panel. There can be several VCPs in a single system - they each operate effectively in parallel.

The CH300V Chairman Control Panel also incorporates a subset of these controls.

The functions of the controls and indicators are as follows:

**SET MODE** - The window displays a mnemonic to indicate the mode selected for the current (or previous) vote. This is O (Open), S (Secret), d (Delayed), I (Interim delayed) or E (Extended delayed). Refer to the Vote Preparation section for further details of these modes. Pressing the button will step through the available modes.
**SET TIME** - The window displays the countdown time selected for the vote in seconds. Pressing the button steps through the available options. A setting of 00 selects a manually timed vote.

**SCREEN DISPLAY** – Pressing the VOTING button causes the Vote Control window to be shown on the screen (equivalent to clicking on the Vote Control icon). Pressing the MIC STATUS button restores the Microphone Control Window to the foreground.

**PRINT INHIBIT** - Pressing this button toggles the printer on and off. The LED indicator illuminates when the printer is deselected.

**VOTING CONTROL** - These buttons and indicators are used to start and stop the voting. Their functions are explained in detail below.

### 3.4 TAKING A VOTE

The procedure for taking a vote is as follows with alternative given depending upon whether the computer screen or the Voting Control Panel is being used:

1. **Vote Selection**
   
   **PC:** From the Vote Control window, open a vote template file (not necessary if using the default VTF). If required, move the mouse pointer to the desired vote entry and click the left button. The Motion, Options, Proposer, Seconder, Mode, Time and Print Inhibit attributes will appear in the boxes in the bottom half of the window.

   **VCP:** The MODE, COUNTDOWN and PRINT INHIBIT displays and indicators show the settings for the selected vote.

2. **Changing Vote Parameters**
   
   **PC:** Change the settings as required by entering new text into the boxes, or making alternative selection(s) via the “spin” buttons.

   **VCP:** Change settings using the buttons as required.

3. **Starting A Vote**
   
   **PC:** Click on the **Start** button at the bottom of the window. The presentation window* will appear. This is where the results are displayed in whatever format has been defined in the VTF.

   **VCP:** Press the **START VOTE** button. The **VOTING ENABLED** indicator illuminates. Note that the voting parameters (motion, proposer, seconder etc.) cannot be changed once the vote is under way.

4. **Suspending A Vote**
   
   Delegates will not be able to make or change votes while a vote is suspended, and the totals will be held.

   **PC:** Click on the **Hold** button. Click on **Hold** a second time to continue.

   **VCP:** Press the **HOLD** button. The **VOTING ENABLED** indicator will extinguish and the **ON HOLD** indicator will illuminate. Press **HOLD** a second time to continue.
5. **Aborting A Vote**

If a vote is abandoned, the system immediately reverts to microphone operation. The voting results are not printed, even if the printer is enabled. However, abandoned votes are saved in a different type of file to guard against operator error.

PC: Click on **Reset**. A confirmation request will appear on the screen.
VCP: Press the RESET button.

6. **Stopping A Vote**

If a timed vote has been selected, the vote will stop automatically at the end of the countdown period. The vote may be stopped manually before the end of the voting period, or if no countdown period was selected.

PC: Click on the **Stop** button.
VCP: Press the STOP button. The VOTING ENABLED indicator will extinguish and COUNT VOTE will illuminate.

At this point, the delegates will no longer be able to vote, although the LEDs on the delegate units will remain lit as confirmation of the way in which they have voted. The LEDs will continue to flash on units that have not been voted from. The presentation window will continue to display the results. At this point the results are saved onto disk, and printed out (if applicable).

7. **Resetting A Vote**

PC: Click on **Reset**.
VCP: Press the RESET button.

The voting LEDs on the delegate units are extinguished and the voting results displays are cleared.

**Nb:** If a Correct Answer has been entered on a multiple-choice vote, it will be displayed at this point. Click on **Reset** or press VCP RESET again to clear down the presentation window.

*Some control computers incorporate a special dual video display adaptor. The software is normally configured so that the voting presentation screen appears on the secondary display output. This secondary output can then be presented to the audience - e.g. by means of a large screen monitor or video projector – sometimes via some form of video switching system (which can also be controlled by the conference computer). The control windows do not appear on the presentation display output.

### 3.5 VOTE RESULT FILES

Voting results are stored as files on the computer's hard disk. They are automatically named to reflect the time and date they were created and have a .VRF extension (.AVF for abandoned votes). The directory where the files are stored is normally:

```
c:\Program Files\Auditel\Votes
```

The files can be opened, viewed and printed using one of the standard Windows® text editors – e.g. Notepad or Wordpad, or inserted in an Office document.
4.0 OTHER FEATURES

4.1 TEXT DISPLAYS

ACCS-S supports two methods of displaying text information to delegates. This information can include speakers’ names, voting results and general notices.

The first, and most traditional, method is via one or more LED (Light Emitting Diode) alphanumeric displays. The generic type number for this type of display is the DP110. The second method is via a “virtual” display, which is actually a secondary screen on the computer, shown either via large screen monitors, or a video projection system. This option requires the computer to be fitted with a special, multi-output video display adapter.

In either case, the relevant functions are handled by the Wall Display module, which is accessed by clicking on the corresponding button on the toolbar above the workspace (see fig. 4.1).

The Wall Display module screen appears as shown in Fig. 4.2. It allows the following actions to be performed:

1. The preparation, storage and recall of pre-programmed text messages.
2. Selection of display mode.
3. Real time message preview and editing.
4.1.1 PRE-PROGRAMMED MESSAGES

Text messages can be created and stored in files on the computer's hard disk for subsequent recall and display at any time.

Each message file can contain a practically unlimited number of messages, and it is possible to store multiple message files – e.g. for different types of meeting.

The File sub-menu provides message file options as follows:

- **New** - Clears the current entries, ready for a new message file to be created.
- **Open** - Allows a different message file to be selected for use. The default file loaded when the system is started is named DEFAULT.MES. If the system is used mainly with one file, it is usually convenient to give it this name. Other files have to be loaded specifically using this method.
- **Save** - Use this to save any changes made to the messages in the current file.
- **Save as** - Use this to save the current file under a new name.
- **Exit** – Closes the Wall Display window.

The messages stored in the currently selected file are shown in the Messages list box. Associated with this box are several buttons as follows:

- **New** – Opens up an edit box, allowing a new message to be created. This will be appended to the current list of messages.
- **Edit** – Loads the currently selected message into the edit box, allowing it to be modified.
- **Delete** – Deletes the currently selected message.
- **1-4** – These buttons each select one of the four messages at the top of the list for display. They duplicate the functions of the DISPLAY MESSAGE buttons on the Microphone Control Panel.

Messages are automatically “wrapped” round onto new lines according to the number of columns available on the display in use, without splitting words. Line breaks appear in the Messages list box as “<br>”.

4.1.2 DISPLAY MODE

Four possible display modes are available:

- **Microphone** – Displays the names of the current speakers. The content and format are determined by configuration. For example, it is possible to select whether full names and titles, requesting delegates, chairman etc. are displayed.
- **Vote** – Shows the voting results. Content and format are determined by configuration and voting mode. The system automatically enters this mode when a vote is initiated, and exits it when the vote is reset. If selected manually while a vote is not pending, the results of the previous vote (if any) are displayed.
- **Message** – Displays the current text message (instead of the microphone status).
- **Split** – Combination of the Microphone and Message modes. The current message is permanently shown on the upper lines of the display. A blank line is
left, and then any names are shown on the remaining lines. Thus, the number of lines available for displaying names will depend upon the message length.

Displays vary greatly as far as the number of characters and lines are concerned. With video based “virtual” displays, font and colour attributes also come into play, extending the permutations even further. The display characteristics and content are reflected in the system configuration, which will in general have been set up when the system was installed.

4.1.3 REAL-TIME MESSAGE DISPLAY & EDIT

To display a message, first double-click on it in the Messages list box. It will then appear below in the Message edit box where it can be modified if required. To force a section of text to appear on a new line, insert a line break by pressing the Return (\n) key.

The message also appears in the Message Preview box. Here, it is shown as it would appear on the real display.

The Clear button can be used to blank the entry. This replicates the function of the CLEAR MESSAGE button on the Microphone Control Panel.

The Live Display box shows what currently does appear on the real display. If the button below the Message Preview box is set to Live On, anything that appears in the Message and Message Preview boxes will be displayed in real time as it is entered*. Setting the button to Live Off gives the opportunity to format the message before it is publicly displayed. The Live On/Off condition can also be toggled by the L button on the Microphone Control Panel.

The Hall Display button is used when in the “Live Off” mode to “publish” the current contents of the Message Preview box to the display. This replicates the function of the HALL DISPLAY button on the Microphone Control Panel.

*Note that the display is updated on a word-by-word basis, not as each character is typed. Thus, a space or line break must be entered before the display is updated.

4.1.4 EXIT

To exit the Wall Display window, click on the Exit button at the top right hand corner, or choose the Exit option from the File menu.

Note that this merely closes the window, it does not shut down the part of ACCS-S that handles the wall display functions. Clicking on the Wall Display button again will bring up the window in the same state as it was left.

Having made changes to any messages in the current file, a warning message will be displayed if an attempt is made to exit ACCS-S without saving them.
4.2 CAMERAS

ACCS-S has support for a Witness Camera System by either Vicon Inc., JVC or Audicam. The cameras and their robotics are “surveillance grade”, but the picture quality is usually quite satisfactory for in-house CCTV, video-conferencing, web casting and projection.

One application for this type of system is to show the current speaker’s image on a projection system within the chamber. Be aware however, that this requires a careful balance of the lighting so as to provide sufficient illumination for the cameras to work properly, but not too much so as to “wash out” the projected image.

Provided that the system is correctly installed and set up as per the instructions contained in this and the Vicon/JVC manuals, camera control is fully automatic and requires no operator intervention. ACCS-S will automatically select the correct camera number and shot programmed for the current speaker and route the video signal accordingly. The only intervention that may be required is to perform occasional fine-tuning of the camera position using the joystick on the front panel of the camera controller. This can be done without affecting the programmed shot.

ACCS-S can also provide an output to a Broadcast Camera System. However, this is not a standard feature and such applications are covered by separate documentation.
5.0 PREPARATION

This section of the manual deals with the administrative processes involved in setting up ACCS-S for use in a particular application.

5.1 DELEGATE EDITOR

One of the important features of the Conference System is the ability to identify delegates by name rather than a numbered seat location. The names are stored in one or more Delegate Files on the computer. These are cross-reference tables that allow the computer to link microphone and/or card numbers with individual names. It is possible to assign operational status parameters to delegates on an individual basis (e.g. whether they are eligible to vote or not), and these, along with other relevant information, are also stored in the Delegate Files. Different files can be prepared and stored on the computer's hard disk for use with different combinations of delegates.

The task of entering all the names for a conference, ensuring that all are correctly typed and entered against the appropriate microphone numbers, is not one to be taken lightly. Where possible, files should be prepared a day or two prior to a meeting - particularly if there are many delegates, or if carrying out the task for the first time.

The Delegate Editor only requires the use of the keys on the alphanumeric keyboard plus the mouse. The buttons on microphone and voting control panels can be ignored, although they will still affect the conference system if this is running. It is not necessary for the rest of the conference system to be running for the purposes of Delegate Entry - it can be carried out with just the computer on its own. Delegate files can even be prepared on another computer if more convenient.

Delegate Files are prepared and maintained by means of the Delegate Editor utility. This can be invoked at any time by single-clicking on the Delegate Editor button above the workspace (see fig. 5.1). On entry, a Delegate Database window opens up in the workspace in the form of a table showing all the delegate records.

The File menu in this box has the following options:

- **New** - Clears the current entries, ready for a new delegate file to be created.
- **Open** - Allows a different delegate file to be selected for use. The default file loaded when the system is started is named DEFAULT.DEL. If the system is used mainly with one file, it is usually convenient to give it this name. Other files have to be loaded specifically using this method.
- **Import** - Imports an old delegate file created under the previous (OS\2) generation of conference control software.
- **Save** - Use this to save any changes made to the records in the current file.
- **Save as** - Use this to save the current file under a new name.
- **Exit** - Closes the Delegate Database window.
The **Edit** menu has the following options:

- **Add** – Adds a new (blank) entry – at the end of the delegate file, and opens it up for editing.
- **Insert** – Inserts a new (blank) entry - *below* the current entry, and opens it up for editing.
- **Edit** – Opens the current entry for editing.
- **Delete** – Deletes the current entry.
- **Renumber** – Renumbers a selected unit, or highlighted group of units. Renumbering can be performed on the microphone, card or PIN fields. A dialogue box appears, enabling the renumber parameters to be entered.

When a new entry is created using the Add or Insert functions, the Mic and Card number fields are auto-incremented from the previous entry. The title and group are also carried over as these are likely to remain the same within a sub-group.

The above options are also available by right-clicking on a record (or group of records). Double-clicking on a record immediately opens it for editing. When a record is edited, a Delegate Editor window appears. Both windows are shown in fig. 5.2 below.

![Delegate Database & Editor Windows](image)

**Fig. 5.2 – Delegate Database & Editor Windows**

A delegate file comprises a number of *records*, each record corresponding to an individual delegate. Each record comprises a number of *fields*, which incorporate the various items of information. The information in the fields is entered and modified via this window.
5.1.1 Delegate

This is where the personal details of the delegate are entered in boxes as follows:

Title - The delegate’s title can be selected from a range of options (Mr, Mrs, Cllr etc.). Alternatively, free text can be entered if the required option is not available.

Forename - The delegate’s first, or given name is entered here.

Surname - The delegate’s last, or family name is entered here.

Group - This can be the name of the delegate’s political party, country or delegation.

The Title, Forename, Surname and Group fields can each accommodate a maximum of 25 characters. Note however that the total number of characters available to display these combined fields in the Microphone Status Window is 40. Above this limit the text will be truncated.

Language – Not used in conjunction with the Envoy system.

5.1.2 ID

This section determines how the delegate is identified to the system.

Unit - A particular physical delegate unit can be assigned to the delegate by entering the unit address here. This field auto-increments as new entries are created, but different numbers can be entered as required. Entries in the range 1 to 9,999 are accepted (although the Envoy system only supports addresses in the range 1-999). For chairman units, entries in the range 0-9 are accepted, the default being zero (although the Envoy system only supports up to three chairman units – 0-2). The editor does permit duplicate unit numbers to be entered, but a warning will be displayed if the file is subsequently opened or saved (see below). A delegate file containing duplicate unit numbers should not be used for a meeting. If it is, the last delegate in the file will be associated with the duplicate unit number, any previous entries with the same number will be ignored.

Pin - Not used in conjunction with the Envoy system. Any entries in this box will be ignored.

Card - Not used in conjunction with the Envoy system. Any entries in this box will be ignored.

5.1.3 Operation

This section allows different operating parameters to be set for the individual delegate.

Status - This determines how a request from the delegate is handled. The options and their effects are:

- **Normal** - requests made by the delegate will be entered at the foot of the request queue.
- **Disabled** - any requests are ignored by the system and immediately cancelled.
- **Preferential** - the microphone will be enabled/disabled immediately the button is pressed.
- **Priority** - delegate requests will enter at the head of the request queue (Q1 position), rather than at the bottom.
- **Chairman** - any chairman’s unit(s) in the system should be identified with this status.
Mic Level - Not used in conjunction with the Envoy system. Any entries in this box will be ignored.

Vote - Determines how delegate votes are handled. Options are:

- **Normal** votes are registered conventionally.
- **Disabled** the delegate cannot register a vote.
- **Casting Only** Not used in conjunction with the Envoy system. Do not select this option.
- **Normal+Casting** Not used in conjunction with the Envoy system. Do not select this option.

Weight - Allows a weight to be assigned to the delegate for use in situations where block voting is a requirement. Values in the range 0-99,999,999 can be entered. A zero value has a similar effect to disabling the vote facility. Note that weighting is only applicable to block votes.

5.1.4 Notes

Any other details which may need to be recorded - e.g. address or dietary requirements can be entered here, up to a limit of 255 characters.

5.1.5 Record

This is simply the number of the record within the file. It is automatically generated and cannot be altered.

Note that the normal Windows® editing functions are available. For example, a highlighted item can be cut from an edit box by pressing **Ctrl-X**. It can then be pasted elsewhere by pressing **Ctrl-V**.

When finished editing the record, click on the **Update** or **Cancel** buttons to exit.

5.1.6 Block Operations

As previously mentioned, an alternative to double-clicking entries in order to open the edit window is to right-click on an entry, whereupon a drop-down menu appears. This give the options of adding, inserting, editing, deleting or renumbering, the same as clicking on **Edit**. However, there are additional options – **Update**, **Mark Present** and **Mark Absent**. The latter come into their own when a **group** of entries is highlighted by left-clicking and dragging the mouse (and in fact, the **Update** option is only available when a group of entries is highlighted).

Moving the mouse pointer down to **Update** brings up another drop-down selection box offering Title, Forename, Surname, Group, Status (microphone) Vote Op, Vote Weight Mic Level and Notes. Selecting one of these brings up an edit box that allows the chosen attribute to be changed for all the selected block of entries at once. This is particularly useful when it is required to quickly enable and disable microphone or voting functions, and indeed, the **Mark Present** and **Mark Absent** options allow this to be achieved even more conveniently by simultaneously enabling and disabling both the microphone and voting operational attributes.
5.2 MIMIC LAYOUT EDITOR

In almost all cases, the workspace will contain by default a “mimic” representation of the seating layout.

A utility is provided to enable a new layout to be created, or an existing one to be modified. This is accessed via the Options menu from the Main Control Window. When this is selected, the default layout (DEFAULT.MLF) will be displayed – e.g. as shown below.

![Mimic Maker Default Layout](image)

The File menu contains the following items:

- **New** - Clears the current entries, ready for a new layout to be created.
- **Open** - Allows a different layout file to be selected for editing.
• **Save** - Use this to save any changes made to the layout in the current file.
• **Save as** - Use this to save the current file under a new name.
• **Print** – Prints the layout on the Windows® default printer.
• **Exit** – Closes the Mimic Maker application.

The **Rotate** menu contains the following items:

• **Clockwise** - Rotates the layout 90° clockwise.
• **180°** - Rotates the layout through 180°.
• **AntiClockwise** – Rotates the layout 90° anti-clockwise.
• **Horizontal** – Performs a reflection about the horizontal axis.
• **Vertical** - Performs a reflection about the vertical axis.

The **Options** menu contains the following items:

• **Size** – Allows the overall size of the grid and the size of the icons to be adjusted. By default, the grid size is 40x40 squares, and the icon is 3 squares high by 2 wide. This can be modified – e.g. to allow for a large number of icons. ACCS-S automatically resizes the workspace to accommodate the resulting layout into the available space.
• **Picture** – Defines the graphic symbol used in the layout editor.
• **Clear Picture** – Changes the symbol used for the icons to a blank one.

The **View** menu contains the following items:

• **Microphones** – Displays the microphone numbers at each icon position.
• **Cameras** – Displays the camera and shot number at each icon position.

To create a new icon, right-click on a blank space. A dialogue box appears thus:

![New Delegate Dialogue Box](image)

**Fig. 5.5 – Mimic Maker Edit Dialogue Box**
The value in the **Microphone Number** box defaults to the next available, but this can be changed as required. For Chairman Units, check the **Chairman** box and enter CH0, CH1 or CH2 as appropriate in the **Chairman Number** box (the default chairman number is 0).

**Orientation** refers to the way in which the icons are orientated. This can be changed to make the best use of the available space and arrive at the required appearance.

The **Multiple** and **Row Details** sections enable multiple positions to be easily created in a single operation. These are mainly intended for frequent users; there is rarely a need to create new layouts in most applications.

For systems with cameras, the camera and preshot number associated with each position is also defined in the Mimic Maker. There is the option to define the preshot as an offset from the microphone number to simplify this operation.

To move an icon, simply click on it and drag to the new location. A “snap to grid” facility automatically aligns the icon to the top left.

To delete an icon, or edit its parameters, right-click on it. A dialogue box appears giving these options.

When finished, save the edited file using the Save or Save As options from the **File** menu. It is possible to create and store any number of different layout files on the computer. The default file loaded when the system is started is DEFAULT.MLF. It is not possible to load in a different layout file from within ACCS-S once it is running, so to use a file, it has to be saved with the default name.

### 5.2.1 **CAMERA PARAMETERS**

As previously mentioned, the Mimic Maker program allows camera and shot numbers to be entered for a camera system. The Program accepts values in the range 1-999 for both parameters, but the actual limit is defined by the capabilities of the camera system used. As an example, for use with the Vicon system, camera and shot numbers must be in the ranges 1-32 and 1-79 respectively.

The default “home” preset (selected when no microphones are live) is camera 1, shot 70. This preset should therefore not be used, other than perhaps for the chairman.
5.3 MICROPHONE TEST UTILITY

The system incorporates the facility to check communications with the delegate network and report the number of units found.

Note: It is not recommended that the test facility be used while a meeting is in progress, as the proceedings may be disrupted.

The utility is accessed via the Options menu from the Main Control Window. When the Test Units option is selected, a window appears similar to that shown in Fig. 5.6 below (although this depicts testing in progress).

![Microphone Test Utility](image)

Fig. 5.6 – Test Units Option

To begin testing, click on the Test menu option. There are options to test individual units, selected units, or the whole system.

When testing individual units, the appropriate microphone is enabled briefly, allowing audio functionality to be verified. The results of the test are also reflected on the microphone mimic.

When testing groups of units, or the whole system, communications are checked by putting the units rapidly in and out of request mode.
5.4 VOTE EDITOR

5.4.1 INTRODUCTION

As outlined in the section on Vote Operation earlier in this manual, votes can have a number of parameters associated with them. These include type (Open, Secret etc.), Motion, Proposer and Seconder details, duration and presentation style.

Any particular meeting session is likely to require a number of votes to be taken each with different parameters. This is particularly so in the case of multiple choice votes where the combinations of questions and choices of output (e.g. Bar Graph or Pie Chart) for each vote could become quite involved. To cater for this, the system enables a voting template file to be created. This holds the setup information for all the votes planned for a particular session.

When the session is started, the selected template file is used as the basis for the votes within that session. The results from each vote are saved on the computer’s hard disk (and in some cases also to a network drive) for future recall, printing and analysis. Since the original template file is unchanged, it can be used repeatedly. This is useful for audience response applications where the same session may be repeated with a different group of people. Alternative templates can be built up and retained on the disk under different names for future use.

The template file does not have to contain an entry for every vote to be taken within a session - just every type of vote. This is because repeat votes can be taken using one vote entry from the template file. The simplest template file can therefore comprise just one vote entry, but any number of votes can be taken using this.

Often it is required to just take simple basic votes and it is not necessary to set up an elaborate template. The system therefore allows a default template to be set up with a few (or possibly just one) types of vote entry. Anyone reading this for the first time and wishing to just carry out a quick trial vote can skip the remainder of this section and execute a vote using the default template supplied with the system.
5.4.2 THE VOTE EDITOR

To start preparing a template, click on the Utilities button above the workspace (see Fig. 5.7), whereupon a Vote Editor button is revealed. Click on this and a window similar to that shown below will appear.

![Fig. 5.7](image1)

![Fig. 5.8 – Vote Editor](image2)

At the top of the window is the usual menu bar with File and Help options. Clicking on File brings up a sub-menu with entries as follows:

- **New** - Starts a new vote template file.
- **Open** - Opens an existing Vote Template File. A dialogue box will appear with the invitation to select a file with .VTF extension.
- **Save** - Saves the Vote Template File currently under preparation.
- **Save As** - Use this option to save a new file, naming it in the process. May also be used to effectively copy an existing file with a different name for subsequent use.
- **Print** - Prints out the Vote Template File on the default printer.
- **Exit** - Exits the Vote Editor.

In fact, the module runs all the time in the background: on exiting, the window is just closed. Therefore, on subsequently returning to the Vote Editor, it will be in the same state that it was left in.

The Vote Editor always starts with the current default file loaded (DEFAULT.VTF). This will normally have just a single vote type stored.
5.4.3 **VOTE SETTINGS**

To create a vote entry, click on the **Add** button at the bottom of the window. This brings up the settings window. The first option in this window – Vote Type – will normally be displayed as shown below.

![Vote Type Window](image)

**Fig. 5.9 – Vote Type Window**

5.4.3.1 **Vote Type**

The first step will normally be to select the type of vote required. Of the options available, only the **Y.A.N./1 of 3** and **Roll Call** are applicable to the Envoy system.

**Y.A.N./1 of 3** – Is 3-way or Parliamentary style voting with Yes/Abstain/No options.

**Roll Call** - This is a special form of vote used to perform an attendance check. When initiated, a standard vote is started. Delegates are required to press (any) one of the voting buttons in order to register their attendance.

5.4.3.2 **Vote Mode**

Five different voting modes are supported. The differences are mainly related to how the voting information is displayed and recorded and are as follows:

- **Open** (O) - This is the default mode for the system. Results, totals and individual (on geographic display) results are continuously displayed and updated every second throughout the voting period.

- **Secret** (S) - At completion of voting, only the totals are displayed and only the totals and headings are saved to disk. The Printer will normally be disabled when Secret Mode is selected.

- **Delayed** (d) - Both individual and total votes are displayed only after the vote has been completed.
Interim delayed (I) - Both individual and total votes are displayed for about 2 seconds at 10 second intervals during the voting period.

Extended delayed (E) - Only individual results are displayed during the voting period. Only when the vote has been completed are the totals displayed as well.

The letters in brackets refer to the corresponding symbol displayed on the Voting Control Panel.

5.4.3.3 Vote Duration

The time allocated for voting can be set here in seconds. If a time is entered, the vote will automatically stop after this duration and no further votes will be accepted. If zero is entered, no time limit is set and the operator will be required to terminate the vote manually.

5.4.4 MOTION

The next step would normally be to enter the motion details. Clicking the Motions tab brings up a page on the settings notebook similar to that shown below.

Fig. 5.10 – Vote Motion Window

The **Number** field will accept any alphanumeric text and things like agenda item number can be entered here. An alphanumeric sort is performed on the final list.

The **Title** is the name of the vote. The entry will be identified by this title in the list of entries in the Vote Editor.

The **Motion** is the question that will be put to the delegates.

**Proposer** and **Seconder** details can be entered in the appropriate boxes if required.
5.4.5 OPTIONS

Clicking the Options tab brings up a window similar to that shown below.

![Vote Options Window](image)

Fig. 5.11 – Vote Options Window

Here the different vote options can be entered, as in the example above.

Lines 1-3 have the text “Yes”, “Abstain” and “No” automatically inserted by default. This can be edited if different terminology is required (e.g. “For” and “Against”).

To the right of each line is a coloured square. Clicking on this will bring up a colour selection window, which allows the colour associated with the option to be altered.

The Answer box allows the “correct” option to be identified. Entering a number other than zero here will cause an additional step in the results display to be introduced when the vote is closed, revealing the correct answer.
5.4.6 OUTPUT

Clicking the Output tab brings up a window similar to that shown below.

![Vote Output Window](image)

This determines how the voting results are displayed. Note that this is only applicable where there is a facility for displaying the votes – e.g. a dual display adapter installed in the computer, connected to a projector or large screen monitor.

The permutations available are too extensive to describe here. It is recommended that the user experiments with this facility to arrive at a satisfactory final layout.

There are four basic types of presentation:

**Text Output**
This uses the “Virtual” DP110 window to display the results in text form.

**Chart Output**
A selection of different graphical outputs. Fonts and colours are set up by clicking on the **Colours** tab (see below).

**Geographic**
This shows the results in a “mimic” format, similar to the microphone mimic window, the icons changing colour to indicate the individual votes.

By default, the layout for the geographic voting display is the same as the one defined for microphone control. It is possible to use a different layout, as follows:

1. To create an alternative layout for the geographic voting display, use the Mimic Maker utility. The layout will usually be the same as the microphone mimic, but from
a different viewpoint, and this is where the Rotate function is useful in creating a new layout based on the microphone layout (DEFAULT.MLF).

2. When satisfied with the new layout, save it using a different name – e.g. VOTING.MLF.

3. Enter the new file name in the Voting Mimic entry in the Files section of the Configuration Editor. See below for further details of the Configuration Editor.

4. Exit ACCS-S and restart it for the changes to take effect.

**List**

Here, the individual votes are displayed in name form. When the vote is first started, all the delegates eligible to vote are displayed in “normal” text. As votes are cast, the relevant names are shown in bold against the appropriate coloured background (e.g. green for “For”). The text is automatically resized so that the names (as entered in the delegate editor) are optimally accommodated on the screen. Fonts and colours are set up by clicking on the Colours tab (see below).

The list display is divided into two columns. A suitable font & size can be selected to fill the display area most effectively. For instance, with only a small number of delegates a tall, narrow font (e.g. “Skyscraper”) may be appropriate. The font chosen needs to be available in normal and bold forms.

The above assumes an Open vote. If a Delayed or Secret vote is selected for example, the corresponding rules apply.

**5.4.7 COLOURS**

Clicking the Colours tab brings up a window similar to that shown below.

![Fig. 5.13 – Vote Colours Window](image)
This allows the foreground and background colours for the voting display screens to be set. The font can also be set by clicking on the **Font** button, whereupon the font selection box is displayed (as shown), enabling any of the installed fonts to be selected.

When finished, click on the **Apply** button at the bottom of the screen to revert to the Vote Editor (fig. 5.8). The new vote will be added to the list, which is sorted alphanumerically. Save the new template file using the Save or Save As options.
6.0 INSTALLATION

6.1 GENERAL

6.1.1 MAINS SUPPLY

All products are designed to operate with a mains supply appropriate to the destination country (where known). Please check the supply voltage settings before deploying the equipment.

In some cases (e.g. computers, printers, etc.), the mains input will be of the “universal” type, automatically adapting to all commonly used supply voltages.

Standard products are supplied pre-set for use at the local mains supply voltage. Units will be configured for either 115V or 230V operation. The equipment is designed to operate from supplies within ±10% of the specified supply voltage, and frequency in the range 50-60Hz. The operating voltage can be determined by examining the setting of the voltage selector switch on the rear panel.

If it is required to supply the unit from a different mains voltage to that shown, it can be altered by observing the following procedure:

1. Ensure that the unit is completely disconnected from the mains supply and unplug the mains connecting lead.
2. Using a small screwdriver, or similar implement, slide the voltage selector actuator to the alternative position so that the required setting is shown.
3. Withdraw the fuse drawer below the mains inlet and replace the fuse with one of the correct rating and type (as shown on the rear panel). There is space for a spare fuse in the drawer.
4. Replace the fuse drawer, connect to the mains supply and switch the unit on.

The colour and functions of the cores in the power supply cable are as follows:

![Power Supply Cable Diagram]

**Fig. 6.1**

The equipment MUST be earthed.
6.2 COMPUTER

The computer is capable of communicating with several different items of equipment (peripherals). The most important of these is the Network Controller from which it receives status information and to which it transmits commands. Other peripherals include System Control Panels, Camera Systems and Displays. Interface to all these are via serial (RS-232) links which allow relatively long distance communication with simple cables.

A minimum system utilises the PC’s own serial port, connected directly to the Network Controller. However, modern PCs tend not to have more than one RS-232 port (if any) and to support any other peripherals it is usually necessary to provide additional ports – either by using add-in cards (desktop style PCs), or USB:Serial adaptors (notebooks and laptops).

The standard solution is to use a desktop style PC equipped with additional serial ports by means of one or two internal 4-port interface cards (QSP-4), and a distribution unit (SIOD-8). Although such cards are fairly readily available, they must be of a specific type, and set up correctly to ensure proper operation. Therefore, it is strongly recommended that the computer is obtained from Auditel with the cards ready fitted, configured and tested.

The computer will be supplied with its own set of manufacturer’s operation manuals. Reference should be made to these for further information on operation and maintenance.

6.3 SOFTWARE INSTALLATION

Installation and configuration of the hardware and software requires a sound knowledge of current PC technology. The hardware and operating system combinations available are practically infinite and it is strongly recommended that the computer and software be purchased from Auditel as a package in order to ensure successful operation.

6.3.1 SYSTEM REQUIREMENTS

ACCS-S is designed to run under Windows® 98, 2000, XP or NT4. The computer should have a minimum CPU speed of 1GHz and at least the minimum amount of RAM recommended for the operating system. Hard disk space required is modest (<5MB). Ensure that the operating system and all required drivers are properly installed before installing ACCS-S.

6.3.2 GRAPHICS CARDS

ACCS-S does not demand high performance graphics capability and any modern card should suffice. It is designed to work best with a screen display resolution of at least 1024x768 with 256 colours. If dual screen capability is required, a dual head graphics card may be fitted. In principle it may be possible to add a secondary display by installing a second graphics card in addition to the PC’s own “native” display. This is not recommended however as there can be a conflict of graphics card drivers.
6.3.3 SERIAL CARDS

PCI Quad Serial Cards and their drivers should be installed one at a time according to the manufacturer's instructions. Check afterwards that Windows® recognises all the serial ports.

6.3.4 ACCS-S INSTALLATION

Only install ACCS-S once all the hardware and drivers have been installed and correctly set up.

After inserting the ACCS-S software CD in the drive, the installation program should start automatically and it is simply a matter of following the on screen instructions.

The installation will create an Auditel folder and an entry in the Programs menu. It is recommended that a shortcut be created and copied to the desktop.

Once the software has been successfully installed, it is necessary to configure it to match the system characteristics as described below.
6.4 SOFTWARE CONFIGURATION

6.4.1 INTRODUCTION

ACCS-S has many operational parameters that determine the way that it works, according to application. These parameters are contained in a configuration file named SETUP.INI, stored in the same directory on the computer as the ACCS-S software itself. This file is loaded in and processed every time the program is started. This means that any changes will only become effective when the program is next restarted.

A utility is provided to make changing these parameters easy. It is called the Configuration Editor and is available from the main Options menu.

Important note: Changing parameters can cause the software to work unexpectedly, or not at all. Only competent persons should carry out modifications to the setup.

When selected, a window with multiple tabs appears as shown in Fig. 6.2 below.

6.4.2 DEVICES

On this screen is defined the various peripheral items that are supported by the ACCS-S software. It is necessary to define here which of the various peripherals are to be used in the system.

Fig. 6.2 – Configuration Editor Devices Tab
6.4.2.1 Display Panels
Select here from the various types of display and control panel supported:

System Control Panel – For example the SCP300V(T).

CPM Mimic – Not applicable to the Envoy system.

NRDP Display – This is a Numerical (voting) Results Display panel using LED numeric display modules. This is essentially a legacy support item as most modern systems use large screen monitors for results display etc.

System Status Message – Data stream that can be used by other systems (e.g. web casting and room control).

6.4.2.2 Camera Switchers
Select here from the various types of camera controllers supported.

These items are mutually exclusive – i.e. it is not possible to use more than one type of controller at the same time.

6.4.2.3 Cameras
ACCS-S can directly control Audicam cameras, obviating the need for a controller in some cases.

6.4.2.4 Card Programmers
Not applicable to the Envoy system – leave set to NONE.

6.4.2.5 LED Displays
Select here from the various types of alphanumeric LED displays supported. These are essentially legacy support items as most modern systems use large screen monitors for display purposes.

6.4.2.6 LCD Displays
Not applicable to the Envoy system – leave boxes unchecked.

6.4.2.7 Biometric Checks
Not applicable to the Envoy system – leave boxes unchecked.

6.4.2.8 Video Switchers
When used in conjunction with a video switcher, ACCS-S can cause the video signal to be switched according to the operational status. For example, it can switch from displaying a camera signal while microphones are in use to showing the presentation screen during voting. Select here from the various types of video switching method supported:

NEC LCD-4000 – This is a projector that can accept multiple video sources, selectable under RS-232 control.

Pioneer PDP-533 – A large screen plasma monitor that can accept multiple video sources, selectable under RS-232 control.

6.4.3 PORTS

Clicking on this tab will bring up a screen similar to that shown below. This is where the various peripherals defined in the previous tab are assigned to the serial ports.

![Configuration Editor Ports Tab](image)

Typically, COM1 and COM2 are reserved for the computer’s own “native” serial ports. In this example, there are at least another four ports provided by one or more 4-port serial cards. Four devices have been assigned to COM ports 3-6, corresponding to ports 0 to 3 on the SIOD-8. The bottom entry shows the drop-down box that appears when the down arrow button is clicked to the right of the entry box. This is the “menu” of devices defined under the previous tab.

The network controller is referred to as the NC50/100 instead of the Envoy system’s DSC50/100, but for the purposes of software configuration these devices are identical.

The RS-232 parameters in the right hand boxes (baud rate, length, parity and stop bits) are automatically inserted and should not be changed.

Unused ports should be set to NULL.

In a minimum system, the DSC50/100 would be connected to the PC’s “native” COM port (usually COM1). This would be set for the NC50/100 and the rest would be NULL.

6.4.4 NETWORK

The settings available here are for use by technical staff only.
6.4.5 FILES

Clicking on this tab will bring up a screen similar to that shown below.

![Configuration Editor Files Tab]

This screen allows the default files and locations used by ACCS-S on startup to be changed. The buttons to the right of each line bring up a browse box to aid in finding alternative files/locations.

The settings here rarely need to be changed because it is usually simpler to give files the default names. There are a couple of points worth noting however:

**Mimic** – This can be changed if it is required to make ACCS-S load up a different mimic file – e.g. for use with an alternative seating layout. However, it is usually simpler to save the various mimic layouts with unique names then load them into the Mimic Maker program and save them as DEFAULT.DEL when it is required to use them.

**Voting Mimic** - This refers to the layout of the icons used for Geographic votes. By default this is the same as that used for the microphone mimic. However, if the image is projected on a large screen, it is often required that the delegates see the layout from a viewpoint that is different from that which is logical for the operator. If this is the case, an alternative (rotated) layout can be created and entered here.

**Vote Print Logo** – This is a logo added to the header of the vote printout.
6.4.6 START

Clicking on this tab will bring up a screen similar to that shown below.

Fig. 6.5 – Configuration Editor Start Tab

Various default operational settings are defined here as follows:

Language – Defines the language for operating menus etc.

Mode – Determines whether ACCS-S starts up in Central or Delegate mode.

Card Mode – Not applicable to Envoy systems. Leave set to Non Card.

Icon Text – Leave set to Seat Numbers.

MAIN MIMIC – Here the visual parameters for the microphone mimic can be defined. It is possible to set the background to be either transparent (showing the desktop underneath), a solid colour (click on the square to the right to modify), or a picture. The latter may be the organisation crest, logo or splash screen. The path name of the picture may be entered in the box to the right. If this is blank, a browse box appears to aid location of the desired file. (Hint – it may be better to use a “washed out” version of the image so that it does not mask the icons etc.). The Foreground Colour and Font attributes are not applicable and cannot be changed.

VOTING MIMIC – The settings are made exactly as per above. It is more likely that a background picture may be selected for the voting mimic as this may be projected for general viewing.
6.4.7 CAMERAS AND DISPLAYS

Clicking on this tab will bring up a screen similar to that shown below.

![Configuration Editor Cameras And Displays Tab](image)

Fig. 6.6 – Configuration Editor Cameras And Displays Tab

The options available under this tab are as follows:

**Camera Information** – The default camera parameters are set here – i.e. it determines what camera shot is selected when no microphones are enabled. Often this is the same as the shot programmed for the chairman unit.

**Video Switch For Plasmas** – This is applicable where the PC is connected to a video switcher, or display device, capable of being controlled by ACCS-S. Buttons for selecting the video source appear in the Wall Display control window, and the caption within these buttons is defined here. They may be sensibly renamed “Cameras”, “Presentation 1”, “DVD”, “Satellite” etc.

The number entered in the Microphone Input Source box is the source that is automatically selected during normal (microphone) operation. This might be the “Camera” source for example. Similarly, the Voting Input Source is the one automatically selected when a vote is in progress – which might be the presentation output of the PC. The secondary values are only applicable if a dual channel video switcher (such as the ISS506SC) is configured.
System Status Message – Configuration options for the System Status Message (SSM) output. These are only available if the SSM device is configured. These should only be changed if directed by technical staff.

LED Wall Displays – If an LED alphanumeric wall display is in use, the number of rows and columns it is capable of displaying are entered here.

LCD Graphic Displays – Not applicable to Envoy systems.

Timer LEDs – Not applicable to Envoy systems.

6.4.8 WALL DISPLAY ITEMS

Clicking on this tab will bring up a screen similar to that shown below.

![Configuration Editor Wall Display Items Tab](image)

The Wall Display is a separate window generated by ACCS-S for presentation display purposes. It can show microphone status information (names of speakers, speech time information etc.) and general messages, or voting results.

Primary Display – Normally the Auto Detect Size box will be checked so that ACCS-S will automatically configure itself to work with the computer’s screen resolution. Occasionally it may be necessary to fix this manually, and this is done in the Width and Height boxes underneath.
Use 2nd Display – Check this to enable the secondary “Presentation” display. When enabled, the Wall Display will always be present, but only visible when the computer is equipped with a dual graphics display facility, (or if it is a laptop PC with dual display capability), and the Windows desktop has been extended onto it. Otherwise, it can only be seen if the main ACCS-S window is dragged off the screen (not minimised), whereupon it can be seen in the background on the desktop.

As with the Primary Display, there is the facility to either allow ACCS-S to determine the size automatically, or to enter the values manually if necessary.

Wall Display – Here the visual parameters for the wall display can be defined. It is possible to set the background to be either transparent (showing the desktop underneath), a solid colour (click on the square to the right to modify), or a picture. The latter may be the organisation crest, logo or splash screen. The path name of the picture may be entered in the box to the right. If this is blank, a browse box appears to aid location of the desired file. (Hint – it may be better to use a “washed out” version of the image so that it does not mask the text etc.). The Foreground Colour and Font may also be set. Any Windows® font installed on the computer may be used, but the use of a fixed pitch font (e.g. Courier New) is recommended to prevent unsightly alignment problems.

Font Alignment – Determines whether the text is displayed aligned to the left or right hand side of the screen, or is centred.

Checking the Grid Lines box causes separating lines to be displayed between the rows.

Show Items – The first column of check boxes relate to the way in which the speakers’ names are displayed.

Checking the Chairman box causes the chairperson’s name to be displayed when the chairman unit is live. This is usually left unchecked as it is usually unnecessary to display the chairperson’s name, and the fact that they are speaking.

Checking the Requests box causes the names of requesting delegates to be displayed. This is generally avoided as the chairperson may prefer to take speakers in non-chronological order in the interests of ensuring a balanced debate, and delegates may feel aggrieved if they believe that they have been bypassed.

Checking the Mic Ids box causes each name to be prefixed with M1,2 etc. for live microphones and Q1,2 etc. for requests. This is how the names are differentiated.

The Mics First In Split box determines whether the speakers’ names are displayed above or below the message text in “Split” mode.

The next three boxes determine whether the current date and time, speech time and voting time are displayed, and the format thereof.

The final column of check boxes determines what information is displayed in addition to the results during a vote.
6.4.9 TIMERS

Clicking on this tab will bring up a screen similar to that shown below.

![Configuration Editor Timers Tab](image)

**Fig. 6.8 – Configuration Editor Timers Tab**

**SPEECH TIMER** – The first box allows the text that precedes the speech time on the wall display to be defined.

The default time is that which appears in the Speech Time box when ACCS-S is started. Time 1 & Time 2 define the values of the "quick set" buttons, Time 3 & 4 are not used.

The 1 Min Time box allows the length of the final "winding up" period at the end of the permitted speech time to be changed. This is the time at which typically an amber light might be illuminated.

Check the Auto box to cause the timer to default to Auto mode when ACCS-S is started.

Check the Auto Mic Off box to cause microphones to be automatically switched off when the timer expires.

**AGENDA TIMER** – Similar to the Speech Timer.

**DIVISION BELL** – Again, similar to the Speech Timer.
6.4.10 DELAYS/QUEUES

Clicking on this tab will bring up a screen similar to that shown below.

![Configuration Editor Delays/Queues Tab](image)

**Fig. 6.9 – Configuration Editor Delays/Queues Tab**

**DELAYS** – These are concerned with communications timings and should not be altered.

**TEST** – This is the number of units that the Test Utility will check if the “Whole” option is selected. It is recommended that this is set to the highest address used in the system to prevent time being wasted attempting to check non-existent units.

**MAX QUEUE** – These boxes determine the maximum number of live microphones, requests and previous speakers that ACCS-S will maintain in its list boxes.
6.4.11 VOTE OPTIONS

Clicking on this tab will bring up a screen similar to that shown below.

![Configuration Editor Vote Options Tab](image)

Most of this screen is concerned with setting the default parameters for voting in the absence of any Vote Template File, and these should be familiar.

The exceptions are the Acknowledge check box in the bottom left hand corner (always leave this unchecked), and the Print Options section, which is self-evident.

6.4.12 SAVING

When any modifications have been made, an asterisk appears at the end of the line “SETUP.INI configuration program” at the top of the screen (see example above) to denote that unsaved changes have been made. Click on the Save tab at the bottom left of the window to save the modified SETUP.INI file (whereupon the asterisk disappears).

Remember that ACCS-S will only recognise the changes when it is started, so shut down the program and restart it for the new parameters to take effect.
6.5 SIOD-8 SERIAL I/O DISTRIBUTION UNIT

In larger systems, with a number of serially driven peripherals, the task of connecting these to the computer is eased by including a SIOD-8. This unit distributes the multiple serial ports onto individual connectors and provides power to drive or activate certain peripherals.

6.5.1 SERIAL CONNECTORS

Each Quad Serial Input/Output Card in the computer incorporates a 37-way connector. From there they connect to the SIOD-8 via a 36-core cable. There may be one or two Quad SIO Cards fitted. The SIOD-8 is normally located close to the PC and the standard cables supplied with each Quad SIO card are 1.5m long. If necessary, these cables can be ordered from the factory pre-made to any specified length.

The cables connect to two male 37-way “D-type” connectors (legended 1 & 2) on the rear panel of the SIOD-8.

Eight female 25-way “D-type” connectors (legended 0 thru’ 7) allow connection of up to eight peripherals (including the Network Controller). Above these connectors is a label strip. This can be legended with the name of the peripheral connected to each port, or with a connector/cable number.

The functions of these ports are determined by the software configuration and differ from system to system as previously described.

6.5.2 MAINS SUPPLY

The primary function of the SIOD-8 is to distribute the various serial connections. This is an entirely “passive” process – i.e. no power is required. The SIOD-8 does however provide several low voltage DC supplies to power peripherals such as the CH300V, and to operate remote activation relays in wall displays. DC power for these purposes is transmitted by wires in the serial connecting cables.

In addition, the SIOD-8 has a mains outlet that is fed via the front panel power switch. It may be convenient to connect this to a distribution block to in turn supply other equipment (the computer, monitor, printer etc.). All the equipment associated with the computer can therefore be turned on and off via a single switch. The switched mains output is not fuse protected. The maximum total current that may be drawn is 9.5 Amps.

Connection to the mains is via an IEC 320 inlet on the rear panel. A mating free cable is supplied with the unit. Maximum power consumption is 120VA, excluding any power drawn from the mains outlet.

When activated, the three LED indicators on the front panel of the SIOD-8 should illuminate. If one or more fails to illuminate, it is indicative of a fault on one of the DC outputs. These outputs are short circuit protected and should recover from such fault conditions. Disconnecting any equipment supplied by the SIOD-8, and unplugging the serial connectors one by one should at some point restore all the LEDs and reveal the faulty connection.

The SIOD-8 should be switched off by means of the front panel switch when the system is not in use. It is normal for the three front panel indicators to take several seconds to fully extinguish – particularly if there is no load connected to the DC outputs.
6.5.3 **AUXILIARY DC SUPPLIES**

The SIOD-8 provides two auxiliary DC supplies to power ancillary items. These outputs are regulated to 12VDC and can provide up to 1 Amp each. They are protected against current and thermal overload.

The auxiliary outputs are available on a 6-way barrier screw terminal block on the rear panel of the unit. The supplies are independent, but the negative side of each is “loosely” connected to mains earth via a 47Ω resistor. This prevents high potentials being electrostatically induced, but should ensure that devices being supplied do not interact.

The necessary cable assemblies will normally be supplied with the ancillary units. Take care to ensure correct polarity.

6.5.4 **SI INTERFACE**

It is possible to link the SIOD-8 to an Simultaneous Interpretation System. This allows the Speak Slowly function to be supported on CH300 control panels. Connection is via a male 8-way “Cinch” connector, legended SI, on the rear panel. Wiring details can be found in the documentation accompanying the SI equipment. The facility is not often used and this connector can usually be ignored.

6.6 **SYSTEM CONTROL PANELS**

Dedicated control panels are available to control Microphone and Voting operations. These are intended for use by the operator, clerk(s) and possibly the meeting chairperson.

6.6.1 **SCP-300V/T CONTROL PANEL**

The SCP-300 is the main type of control unit. In its basic form is a free-standing console which houses a Microphone Control Panel. Voting and Timer Control Panels may also be incorporated, denoted by V and T suffixes to the SCP-300 type number.

Any number of SCP’s can be connected to the system within the limit of available serial ports. Multiple panels operate functionally (not electrically) in parallel.

Flush-mounting versions are also available to order.

6.6.1.1 **Serial I/O Connector**

On the rear of the SCP-300 is a female 25-way “D-type” connector. This connects to the SIOD-8 via a 4-core serial cable (type 1, although any of the types 1-3 can be used). A pre-made cable is supplied with the unit but frequently connection is made via an installation cable. A drawing showing connection details for the serial cable can be found towards the end of this manual. No additional connections are required to support voting and timer functions.

The actual port on the SIOD-8 into which the SCP connects is determined by the software configuration (see above). However, the first two SIOD-8 port outlets (0&1) are almost always configured for an SCP and Network Controller (DSC50/100) respectively.
6.6.1.2 Mains Supply

SCP consoles require local mains power. This should preferably be switched by the main breaker controlling the conference system to avoid having to isolate the unit(s) individually when the system is not in use. Alternatively, it may be convenient to power a unit from the switched mains outlet of the SIOD-8 via a suitable mains distribution unit, along with other associated equipment. Power consumption is 30VA max. (excluding any timer lamp consumption).

The mains input is via a standard IEC 320 connector and a mating free cable is provided.

If the unit is to be operated from a different mains supply to that specified on the rating plate, it can be altered by means of the selector switch fitted to the rear panel. Before doing so, ensure that the equipment is disconnected completely from the supply. Having altered the setting, the AC mains fuse will need to be changed. Correct values are 315mA(T) for 115V operation and 160mA(T) for 230V operation. The rating plate should also be altered to show the new operating voltage.

6.6.1.3 Timer Lamp Outputs

SCP-300T, or SCP-300VT models, incorporating speech timer facilities, have three IEC-320 mains outlets. These are to drive "traffic light" style Speech Timer lamps to suit the application. Power rating should be no more than 100W per lamp.

The mating connectors for these outputs are not normally included.

6.6.2 CH-300V CHAIRMAN AUXILIARY CONTROL UNIT

The CH-300V is a small panel incorporating a number of the more commonly used microphone and voting control keys. It is intended to provide the meeting chairperson (or other appropriate person) with limited control facilities.

The standard CH-300V is a portable unit that occupies minimal desk area. Flush mounting versions for incorporation into the desktop are also available to order.

6.6.2.1 Installation

The CH-300V incorporates a 2m captive cable via which it connects back to the SIOD-8. The unit also draws its power from the SIOD-8 through this cable.

Usually the unit will be located some distance from the SIOD-8 and an extension cable will need to be prepared. This is essentially a type 3 serial cable, but with a female connector at the CH-300V end (perhaps fitted on a floor or wall plate) to accept the plug fitted to the end of the unit’s captive cable. Flush mounting units are generally fitted with a female 25-way “D-type” connector to allow a standard type 3 serial cable to be used for connection back to the SIOD-8.
Note that all 8 cores of the type 3 cable are actually only required if the Speak Slowly\(^1\) function on the CH-300V is needed. If not, a type 1 serial cable (4-core) will suffice.

The CH-300V is electrically interchangeable with the SCP-300 consoles and will function on any port configured as an SCP device. However, note that only port 2 is wired for the Speak Slowly function, so the facility will only operate when the CH-300V is connected to this port.

### 6.7 VIDEO DISTRIBUTION AMPLIFIERS (VS-104/8)

The high resolution (XGA) video standard universally used in modern Personal Computers does not lend itself to the support of monitors sited more than a few metres from the source. The frequencies in use are commonly much higher than in broadcast systems and this places stringent demands on the VDAs and cables used if picture degradation is to be avoided.

It makes available 4-way (VS-104) and 8-way (VS-108) VDAs which allow three or seven additional monitors to be supported at distances of up to 65m. Above this distance special, more expensive VDAs may be required.

The video cable and connectors required can be difficult to obtain and terminate. We can supply video cables pre-made in lengths to order.

Most video projectors and LCD/Plasma displays will accept XGA signals direct and can also be driven from a VDA output.

The VS-104/8 is powered from its own plug top power supply.

### 6.8 PRINTERS

A printer will normally be required if the system includes voting in order to print out the results.

ACCS-S will work with any normal Windows\(^\circledR\) compatible printer, usually connected via a USB port. Please refer to the documentation accompanying the printer for specific information. Ensure that the software drivers for the printer to be used have been loaded and that a test page can be printed.

### 6.9 TOUCHSCREENS

Touchscreens are installed as standard Windows\(^\circledR\) devices. Refer to the accompanying documentation for details. The only real point to make about these devices is that they do not connect via the SIOD-8, but directly into one of the PC’s “native” serial ports (COM1 or COM2), or into a USB port.

---

\(^1\) The Speak Slowly function is a facility of the Interpretation System and is only applicable to systems which incorporate Simultaneous Interpretation, and which require this facility. Refer to the Interpretation System Operation Manual for further details.
6.10 WALL DISPLAYS

There are three basic types of wall display. These are now largely “legacy” items, superseded by video display methods for all but a few specialist applications.

1. NRDP-5
This is a Numeric Results Display Panel, with 5 sets of numeric displays. These normally display the Yes, Abstain, No, Total and Countdown voting parameters.

2. GEOG-X
These are Geographic displays, with coloured lamps to indicate the individual voting status of the units in the system (the “X” corresponds to the number of units represented). Often they would be combined with NRDP displays.

3. DP110 Alphanumeric Displays
The DP-110 is an LED matrix alphanumeric information display unit capable of displaying microphone and voting status information, general text messages or a combination of these under control of the computer. The standard display has 5 lines of 20 characters with a character height of 50mm, allowing a viewing distance of up to 30m. Displays are available with other numbers of lines, characters and character sizes.

6.10.1 INSTALLATION

In general, displays are designed to be mounted on the wall via suitable fixing bolts. Two “keyhole” slots are incorporated to facilitate this. However, most displays tend to be custom made for the application and mounting arrangements will vary accordingly.

The displays are wired into the correct port on the SIOD-8 and connected to a mains supply. The serial connection is via a female 25-way “D-type” socket. A 4-core (type 1) serial cable is required, and a standard one (3m length) is normally supplied with the unit. Usually this will be replaced by a (longer) installation cable and a drawing showing connection details can be found towards the end of this manual. The factory supplied cable can be used for verifying functionality if required.

The actual port on the SIOD-8 into which the display connects is determined by the software configuration as previously described.

In systems with more than one display, each will normally be connected back to its own port on the SIOD-8. In some cases however, multiple displays may be connected back to the same port on the SIOD-8. Refer to the system documentation for details.

6.10.2 MAINS SUPPLY

The general guidelines for mains supply at the top of this section apply. Note that displays, being application specific, are not normally fitted with voltage selector switches.

The mains input is via a standard IEC 320 connector and a mating free cable is provided. Power consumption varies according to specification but is typically around 500VA.

Displays are designed to be connected to a permanently live mains feed. Internal relays, activated via the serial cable, disconnect the supply when the SIOD-8 is switched off.

All the above displays use the same type of 4-core o/s serial cable (type 1). Two of the cores in the cable carry a DC activation signal from the SIOD-8 that operates a relay
within the display to switch the mains supply internally. This allows the supply to the display to be permanently applied without residual power drain.

### 6.12 WITNESS CAMERA SYSTEM

The Witness Camera System to which this section refers is based on “surveillance” grade cameras, as distinct from “broadcast” type camera systems. ACCS-S is compatible with specific equipment manufactured by Vicon and JVC or Audicam. It is strongly recommended that the equipment is purchased through along with the computer so that it will have been system tested as a package before shipment.

The camera system should be installed according to the documentation supplied by the manufacturers. Further information may found in the appendices at the end of this manual.

### 6.13 STANDARD SERIAL CABLES

The Type 1 cable is used to connect all serial displays (DP110, NRDP, GEOG) plus the SCP series and CH300V consoles to the SIOD-8 (but see Type 3 below). It is also used for the System Status output (with connections to pins 13 & 25 omitted):

![Fig. 6.12 – Type 1 Serial Cable](image-url)
The Type 3 cable is used for the SCP and CH300V consoles – but only if the Speak Slowly link to a Simultaneous Interpretation system is implemented:

Fig. 6.13 – Type 3 Serial Cable

The Type 10 cable is used to connect the DSC50/100 to the SIOD-8:

Fig. 6.14 – Type 10 Serial Cable
The Type 11 cable is used to connect the DSC50/100 directly to the PC’s “native” serial port:

Fig. 6.11 – Type 11 Serial Cable
A1 VICON WITNESS CAMERA SYSTEM

A1.1 INSTALLATION

A1.1.1 Dome Cameras
Please refer to the Vicon manual XX002 for the type of data and video cables to be used since the configuration varies according to cable distance, as detailed in the manual. The manual will also cover details of installing the cameras, either within a ceiling void or pendant style to a wall or ceiling.

Vicon advise connecting the data cable for the dome cameras in daisy-chain fashion. If the data cabling is to be a star configuration, the use of a data distribution unit is recommended.

Up to 31 cameras may be connected to the Nova matrix unit. Each camera on a system needs to be set to a unique number.

A1.1.2 Vicon Nova Matrix
The Vicon manual X826 should be referred to for the installation and operation of the Nova matrix system. Vicon recommend that each of the unused camera inputs be terminated using the 75ohm terminators supplied.

A useful tip is to make a connection between the MON1 output and the camera 32 input. By assigning the various other monitor outputs to camera 32, the unit will output the same video signal on all monitor outputs, thus saving the necessity for a separate video distribution amplifier.

The computer communicates with the matrix via a serial cable that runs between the SIOD-8 (normally port 5) and the RS-232C connector on the matrix. The cable is made up as follows:

<table>
<thead>
<tr>
<th>Pin No. (9-way)</th>
<th>Pin No. (25-way)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>7 (screen)</td>
<td></td>
</tr>
</tbody>
</table>

A1.2 CONFIGURATION

The aim of this section is to:

- Set the communications parameters to enable the Nova matrix to communicate with the conference computer
- Configure the dome cameras with the necessary preset shots and to ensure that titles superimposed onto the video images only appear at the discretion of the installer.

A1.2.1 Vicon Dome camera
For the configuration of the Vicon Surveyor99 Dome camera refer to Vicon document XX003.
The table below shows the preset numbers and their functions.

<table>
<thead>
<tr>
<th>Preset No.</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 79</td>
<td>Preset Positions</td>
</tr>
<tr>
<td>80 to 87</td>
<td>Tour sequences</td>
</tr>
<tr>
<td>88 to 89</td>
<td>Auto tour sequences</td>
</tr>
<tr>
<td>90</td>
<td>Pan/Tilt lockout</td>
</tr>
<tr>
<td>93</td>
<td>Set manual pan limits</td>
</tr>
<tr>
<td>94</td>
<td>Enter dome menu system</td>
</tr>
<tr>
<td>95</td>
<td>Auto-Baud detect feature</td>
</tr>
<tr>
<td>96</td>
<td>Program dome sectors</td>
</tr>
<tr>
<td>97</td>
<td>Initiate dome reset</td>
</tr>
<tr>
<td>98</td>
<td>Auto pan left limit</td>
</tr>
<tr>
<td>99</td>
<td>Auto pan right limit</td>
</tr>
</tbody>
</table>

In this context, only presets 1-79 and 94 are of interest. Since each camera can only store 79 presets, systems with more than this number of microphones generally have more than one camera. Indeed, systems with less than this number may also have more than one camera in order to improve the views obtainable.

ACCS-S directs the camera system to show either the first live microphone or, when no microphones are live, a pre-defined view - typically a general view of the dais. Each microphone requires a preset camera and shot assigned to it. The camera and shot numbers are entered via the Mimic Maker program (see Preparation section).

**Setting The Camera Shot Presets**

Before proceeding it is worth spending some time looking at the shots available from the cameras and making notes regarding which cameras and preset shot number will be assigned against which microphones.

The presets are assigned via the Nova Matrix front panel. The procedure for each of the cameras is as follows:

1. Move the PGM/RUN switch to the PGM position.
2. Using the joystick and the zoom in/out switches, achieve the desired view relevant to the microphone number.
3. Press the PP ENTER button.
4. Enter the preset number (1-79).
5. Press the PP ENTER button.
6. Repeat steps 2 to 5 as required.
7. Return the PGM/RUN switch to the RUN position.

Having programmed the preset shots to a camera check to ensure that the shot has been configured correctly, repeating the steps above where necessary.
Programming The Cameras

The camera domes are programmed using preset number 94.

1. On the Nova matrix move the PGM/RUN switch to the PGM position.
2. Press the PP ENTER button on the Nova matrix.
3. Enter 94.
4. Press the PP ENTER button.

Many features of the cameras may be programmed. However this document will only consider the inhibiting of source titling of the cameras. After entering preset 94, the main programming menu will be presented. Use the joystick and the AP key to select Source Titling.

Use the joystick and the AP key to select the Enable Titles option. Now disable all of the options.

Finally, return the PGM/RUN switch to the RUN position.

A1.2.2 Nova Matrix

For the programming of the Nova matrix refer to the Vicon manual X834. To begin the programming connect a monitor to monitor output number 8, on the rear of the matrix unit.

Configure host port

The settings required are as follows:

- Select baud rate 300
- Select the Data Bits 8
- Select the Stop Bits 1
- Set the Parity None

Enable Displays

This menu item is used to inhibit the displaying of information on the monitor outputs. The changes need to be done to each of the eight monitors. It is not possible to make changes to the monitor being used as the Programming Monitor. Therefore, after making changes to 7 monitors it will be necessary to leave the programming screens, move the monitor connection to monitor output number 7 and return to these menu items.

The Enable Displays menu item is to be found under the following menu path:

- Main Menu>Time/Date/Titler>Display Controls>Enable Displays

Set Default Call-Up

This will define the condition for each of the monitors at power-up. Set as follows:

- Assign Monitor 1 to Camera 1
- Assign Monitors 2-8 to Camera 32

This menu item has the following menu path:

- Main Menu>Video Switch Action>Set Default Call-Up
A2  JVC CAMERA SYSTEM

This appendix describes the particular measures required to interface to the JVC RM-P2580E camera controller. In fact up to two controllers can be connected to support up to 15 cameras, as will be described. The controllers can handle up to 64 presets per camera, giving a theoretical maximum of 960 presets.

A2.1 HARDWARE SETUP

First set up the cameras and controller(s) according to the information given in the manufacturer’s documentation. Ensure that when this is done, the cameras can be properly controlled by manual means, and that they respond to entering of presets.

The controllers are configured in the “A” mode – all poles of the rear panel DIP switch are set to the “OFF” position.

The computer communicates with the controller via a serial cable that runs between the SIOD-8 and the SERIAL-1 connector on the controller. A two-core, non-twisted pair, screened cable is required with connections as follows:

<table>
<thead>
<tr>
<th>RM-P2580E Pin No. (9-way)</th>
<th>SIOD-8 Pin No. (25-way)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>5</td>
<td>7 (screen)</td>
</tr>
</tbody>
</table>

The actual port(s) to be used on the SIOD-8 is determined by the software configuration (see below).

If using two controllers:
1. Connect cameras 1-7 to the first controller, leaving video input 8 free.
2. Connect the rest of the cameras (up to 8) to the second controller. Number these from 1 upwards also.
3. Link the VIDEO INPUT 8 on the first controller to MONITOR OUTPUT 1 on the second controller via a short 75Ω BNC-BNC cable.

Video outputs are available from the MONITOR OUTPUT 1 & 2 connectors of the first controller.

A2.2 SOFTWARE CONFIGURATION

This is best carried out using the SETUPINI.EXE configuration editor, which is located in the Auditel directory. If you do not have this utility, contact Auditel for an up to date version.

On starting the SETUPINI program, first, click on the PORTS tab. Decide on a suitable port to use (or two ports if it is a dual controller system), and select the JVC Camera option from the drop down list. Figure A2.1 shows how the screen might look when this has been done:
Next, click on the **CAMERAS** tab. Here it is possible to enter the information for the default preset – i.e. that selected when no microphones are enabled. Often this is the same as the chairman’s preset, or it could be a “long” shot of the podium. The Default Monitor parameter is not applicable to the JVC camera system (leave at 1).

When finished, click on the **Save** button. The saved parameters will be loaded in and used the next time ACCS-S is started.
Camera presets for the individual seats are entered in via the MIMICMAKER utility (see section 5 of this manual).

A2.3 OPERATION

Camera system operation is fully automatic. Unlike a broadcast system, a Witness Camera System only generates one video output. ACCS-S always selects the shot corresponding to the current live microphone. If there is more than one live microphone, the “oldest” (M1) is the one selected.

When no microphones are enabled, a default shot is selected as explained previously.

While a delegate is talking, it is possible to adjust the current shot manually using the controls on the console. These changes will only prevail for as long as the current shot is selected.
This appendix describes the particular measures required to interface to the Audicam camera controller. The controllers can handle up to 99 presets per camera, giving a theoretical maximum total number of presets in excess of 1500.

### A3.1 HARDWARE SETUP

First set up the cameras and controller according to the information given in the manufacturer's documentation. Ensure that when this is done, the cameras can be properly controlled by manual means, and that they respond to entering of presets.

**NOTE:** The Audicam dome cameras should be connected to the RS-485 camera port 2. The cameras cannot be operated from RS-485 camera port 1. The controller is initially setup to send data to RS-485 camera port 1 for all cameras; this should be changed through the setup menu so that all camera's are connected to RS-485 camera port 2.

The computer communicates with the controller via an RS-485 serial link. The RS-232 output from the computer is converted to RS-485 either via an Altronix AL-300 converter, or else the computer is fitted with a serial card that can directly output RS-485.

If an RS-485 converter is used, refer to figure A3.1, which details the connection of the SIOD-8 to the converter, and the converter to the Audicam video matrix.

If a Moxa serial card is installed in the PC, refer to figure A3.2, which details the connection of the serial port to the Audicam video matrix.

![Fig. A3.1 - Connecting the Matrix Switcher to the PC via a SIOD-8](image-url)
A3.2 SOFTWARE SETUP

This is best carried out using the SETUPINI.EXE configuration editor, which is located in the Auditel directory. If you do not have this utility, contact Auditel for an up to date version.

On starting the SETUPINI program, first, click on the DEVICES tab. Click the radio button next to the Audicam Camera option. Figure A3.3 shows how the screen might look when this has been done:

Fig. A3.3 – Select the Audicam Camera Option
Next, click on the PORTS tab. Decide on a suitable port to use, and select the Audicam Camera option from the drop down list. Figure A3.4 shows selecting Com5 (SIOD8_2) for the Audicam camera serial connection:

![Configuration Program Window]

*Fig A3.4 – Assigning the Audicam Camera to a serial port.*

Finally click on the CAMERAS AND DISPLAYS tab. Set the camera default values to the appropriate values for the system (see Fig. A3.5 below).

The Default Preset is the preset that will be selected when no microphones are active. Often this will be the same as the preset for the chairman. It is recommended that this be set to a higher number – if possible above the highest delegate address. This allows at least some correlation to be achieved between delegate addresses and preset numbers (e.g. Delegate Unit 001 maps to Camera 1, Preset 1).
When finished, click on the **Save** button. The saved parameters will be loaded in and used the next time ACCS-S is started.

**A3.3 OPERATION**

Camera system operation is fully automatic. Unlike a broadcast system, a Witness Camera System only generates one video output. ACCS-S always selects the shot corresponding to the current live microphone. If there is more than one live microphone, the “oldest” (M1) is the one selected.

When no microphones are enabled, a default shot is selected as explained previously.

While a delegate is talking, it is possible to adjust the current shot manually using the controls on the console (although you must log in as a user before the joystick is activated – see below). These changes will only prevail for as long as the current shot is selected.

**A3.3.1 Manual Camera Control**

After power up the front panel controls of the Audicam camera system matrix are disabled by default. It is necessary to log in as a user in order to gain access to the control functions. The factory default is User 1, with a password of 12345. To log in as this default user, press button 1, followed by **CAM**. The Login indicator will then flash. Enter the password (12345), followed again by **CAM**. The **LOGIN** indicator should now light permanently. If the password was entered incorrectly, the **PROHIBIT** light will flash. Start again by typing in the user number. For information regarding the adding of new users, changing of passwords etc., please refer to the camera system documentation.
Once logged in, the joystick will now control the current camera, and the output will be displayed on the currently selected monitor. To change camera, enter a number (1-32) followed by `CAM`. To change the monitor output, enter a number (1-8), followed by `MON`. Note that these limits are for a fully expanded system; as a stand-alone unit, the Audicam matrix supports up to 16 cameras and 4 monitors.

### A3.3.2 Saving and Recalling Presets

To set a preset, first ensure that the correct camera is selected. Adjust the camera using the joystick to obtain the desired image. Next, enter the preset number (1-99), and then press the `SET PRESET` button. Note that there is no feedback on the front panel, or the video image to confirm this process.

To recall a previously saved preset, type in the number of the preset followed by `CALL PRESET`.

Once the presets have been stored, the front panel controls can be disabled to prevent any further changes being made by pressing `LOG OUT`. 